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1.

Informacién general

1.1 Informacion general del software

XenData6 Workstation es un software de archivado y restauraciéon de cintas de datos LTO que se
utiliza con el Explorador de Windows. Admite una o varias unidades de cintas LTO conectadas a
un equipo con un sistema operativo Windows y es capaz de administrar un ndmero ilimitado de
cintas LTO sin conexidn. Asimismo, el software permite crear informes para administrar el sistema
de archivado, asi como también listar el contenido de una cinta, buscar archivos y generar un
informe Archive Status.

Para ver una lista de los tipos de unidades LTO y sistemas operativos Windows compatibles con
esta version de XenData6 Workstation, consulte el sitio web de XenData enwww.XenData.com.

Las operaciones de archivado y restauracién siempre se realizan con el Explorador de Windows.
XenData6 amplia las funciones del Explorador de Windows para transferir archivos a o desde una
unidad de cinta LTO mediante arrastrar y colocar, o copiar y pegar. Los archivos se pueden archivar
en una LTO desde cualquier unidad légica accesible o desde cualquier recurso compartido de la
red. Del mismo modo, los archivos se pueden restaurar en cualquier unidad I6gica accesible o
recurso compartido. El sistema mantiene las estructuras de archivos y carpetas, por lo que es posible
transferir carpetas anidadas a o desde la cinta LTO. Las operaciones de archivado y restauracion
se abordan en los apartados Archivar archivos en una LTO (3.1) y Restaurar archivos de una LTO
(3.2). XenData6 Workstation ofrece la posibilidad de copiar en una LTO solo los archivos que hayan
cambiado o que sean nuevos. Es una manera facil de crear en una LTO una copia actualizada de
las carpetas de un proyecto.

Como es posible mantener la estructura de archivos y carpetas almacenados en todas las cintas
gue alguna vez estuvieron insertadas en la unidad (o unidades) de cinta LTO, XenData6
Workstation es el software idoneo para controlar un sistema de archivado en cinta LTO de gran
tamafio sin conexion. El sistema de archivado permite examinar todas las cintas externas sin
conexion. Esta funcién se explica en el apartado Acerca de la estanteria LTO (4.4). Con un informe
File Search se puede generar una lista de archivos que cumplen los criterios de busqueda
especificados por el usuario y determinaran las cintas que contienen cada coincidencia.

XenData6 Workstation escribe en la cinta LTO usando el formato de estdndar abierto TAR o el
formato intercambiable LTFS. Estos formatos (también denominados «sistemas de archivos») se
abordan en el apartado Acerca de LTFS y TAR (1.3). Las cintas grabadas con el software
XenData6 Workstation se pueden utilizar en los sistemas de servidor que ejecutan el software
XenData6 Server. El software XenData6 Workstation incluye una serie de funciones adicionales:

e Compatibilidad con todos los tipos de archivos. (Incluidos los archivos que no son de
video.)

e Las unidades LTO-6 disponen de verificacion de archivos en tiempo real. Para obtener
mas informacion, véase Acerca de la proteccién de bloques légicos (1.8).

e Se pueden utilizar cartuchos de cinta LTO WORM tanto regrabables como no borrables.
Para obtener mas informacion, véase Acerca de LTO (1.2).

e Las cintas LTO se pueden agrupar en conjuntos de volimenes de XenData. Esto es
especialmente (til al intercambiar las cintas en sistemas de servidor que ejecuten el
software XenData.



http://www.xendata.com/

1.2 Acercade LTO

Linear Tape Open (LTO) es el formato de cinta mas habitual, que utiliza tecnologia desarrollada
por HP, IBM y Quantum Corporation. La Ultima generacion de LTO es LTO-6, que ofrece alta
capacidad de almacenamiento, transferencia de archivos de alta velocidad y larga duracion de los
datos archivados:

e Enorme capacidad de almacenamiento. Cada cartucho de cinta LTO-6 almacena 2,5 TB
sin necesidad de compresion. Para archivos de video, esto equivale a mas de 100 horas a
una velocidad de grabacién de 50 megabits por segundo.

e Transferenciade archivos de alta velocidad. Las unidades de cinta LTO-6 graban y leen
las cintas a velocidades de hasta 160 megabytes por segundo.

e Largaduraciéon de los datos archivados. Los cartuchos de cinta LTO pueden ser de
varias marcas. Cada fabricante especifica una duracién de archivado de 30 afios.

Las unidades de cinta LTO-6 son compatibles con los cartuchos de cinta LTO-6 de 2500 GB, LTO-
5 de 1500 GB y LTO-4 de 800 GB. Las cintas LTO-6 y LTO-5 son totalmente compatibles con las
operaciones de lectura y escritura, mientras que las cintas LTO-4 no se pueden grabar pero si leer
en unidades de cinta LTO-6.

Las unidades de cinta LTO-5 son compatibles con los cartuchos de cinta LTO-5 de 1500 GB, LTO-
4 de 800 GB y LTO-3 de 400 GB. Las cintas LTO-5 y LTO-4 son totalmente compatibles con las
operaciones de lectura y escritura, mientras que las cintas LTO-3 no se pueden grabar pero si leer
en las unidades de cinta LTO-5.

Los cartuchos de cinta LTO estan disponibles como regrabables o como WORM. WORM es el
acronimo de «Write Once Read Many», que significa 'escritura Unica y lectura mdltiple'. Los datos
grabados en un cartucho de cinta WORM LTO no se pueden modificar. Esto significa que, a
diferencia de los cartuchos regrabables, las cintas WORM no se pueden formatear ni reutilizar.
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1.3 Acercade LTFSy TAR

Esta version de XenData6 Workstation es compatible con los formatos LTFS (Linear Tape File
System) y TAR (Tape ARchive), propios de los sistemas de archivos de los cartuchos. Estos
formatos definen como se graban los datos en la cinta: LTFS y TAR utilizan estructuras de datos
distintas para los datos de los archivos y los metadatos del sistema de archivos que se graban
en la cinta. Al formatear un cartucho LTO, el usuario puede elegir TAR o LTFS como formato
del sistema de archivos del cartucho.

El formato LTFS, desarrollado por IBM, fue anunciado en 2010. Desde entonces, ha sido
adoptado ampliamente y se ha convertido en el formato estandar para intercambiar cartuchos
en sistemas de distintos fabricantes. LTFS utiliza dos particiones en el cartucho LTO: una
particion de indice pequefia para mantener el contenido de la cinta, y una particion de datos de
gran tamafio para almacenar los archivos. Se puede utilizar en cartuchos LTO-5 regrabables y
en las generaciones posteriores de cartuchos LTO. Un cartucho de cinta grabado en formato
LTFS es autodescriptivo y el contenido del cartucho se puede determinar rapidamente leyendo
una particién de indice de la cinta. Son compatibles con el formato LTFS las siguientes
combinaciones de unidades y cartuchos LTO:

e Unidades LTO-6 y cartuchos regrabables LTO-6 de 2,5 TB
e Unidades LTO-6 y cartuchos regrabables LTO-5de 1,5 TB
¢ Unidades LTO-5 que admitan particiones dobles y cartuchos regrabables LTO-5de 1,5 TB

Con LTFS no se pueden utilizar los cartuchos LTO-4 ni ninguna de las generaciones de
cartuchos WORM LTO.

El formato TAR fue presentado en 1979 y es un estdndar abierto ampliamente adoptado. Es
compatible con muchos sistemas operativos, entre los que se incluyen la mayoria de las
versiones de UNIX, Linux y Microsoft Windows Services para UNIX. Se puede utilizar en
cualquier tipo de cinta de datos, incluidas todas las generaciones de cintas regrabables y WORM
LTO. Los cartuchos de cinta grabados con el formato TAR son autodescriptivos. Sin embargo,
si se utiliza una implementacion de TAR basica, es necesario analizar toda la cinta para
determinar su contenido. El software XenData6 Workstation amplia el formato TAR manteniendo
un catalogo del contenido de los cartuchos y grabando dicho catalogo al final de la cinta en una
operacion de finalizacion.

Cuando un cartucho de cinta finalizado, grabado en formato TAR, se utiliza en otro sistema
de XenData, el contenido se determina con rapidez porque el sistema lee automaticamente
el catalogo.




1.4 Licencias del software

1.4.1 Acercade las licencias

XenData6 Workstation se distribuye mediante licencias en el marco del Contrato de Licencia
para Usuarios Finales (End-User License Agreement o EULA), que debe ser aceptado al
instalar el software. El software XenData6 Workstation solo se puede utilizar para acceder
a unidades de cinta especificas a las que se haya asignado una licencia valida y auténtica
con el fin de leer o grabar datos.

De acuerdo con lo establecido en el Acuerdo de Licencia, si el usuario ha comprado una
licencia de XenData6 Workstation para usarla con una sola unidad de cinta, debera asignar
una unidad de cinta especifica a esa licencia. Posteriormente, el usuario podra instalar el
software XenData6 Workstation en varios equipos y utilizar la unidad de cinta asignada en
cualquiera de ellos.

1.4.2 Co6mo obtener unalicencia

Para usar el software XenData6 Workstation se necesita un codigo de activacién de XenData.
El software se activa mediante un programa denominado XenData License Administration
Utility, que puede abrirse durante la instalacién. Este programa también se puede abrir una
vez instalado el software, tal como se indica a continuacién:

e Windows 7:
o Haga clic en Inicio > Todos los programas > XenData.
o Haga clic en License Administration.

e Windows 8.1 y Windows 10:
o Abra la pantalla Inicio y haga clic en la flecha abajo de la esquina inferior
izquierda para abrir la vista de aplicaciones.
o En la seccién de XenData, haga clic en License Administration.

Aparecera la License Administration Utility.

 Activation option oK.

Machine  [NIC:7071BCDC4850 | & |otermet
Activation code [\w58CEBSCES ¢ Import file Cancel

_J " Generate request for license

Apply

KenData Archive Series

ActivationCode: WS8CBBBCB8
MachineID: NIC:7071BCDC4850
SystemlID: 4DSCSARF
SystemType: WorkStn
Maintenance: 2012/038/17
LibraryCount: 0
DriveCount: 1
StandaloneDrives: 5
MediaTypes: 200GB RW Tape
400GB RW Tape
400GB WORM Tape
800GB RW Tape
B800GB WORM Tape
1500GB RW Tape
1500GB WORM Tape
SerialNumber: HU1041D1YA

Si el equipo para el que se desea obtener la licencia cuenta con acceso a Internet, escriba
el cadigo de activacion, haga clic en Apply (Aplicar) y luego en OK (Aceptar) para activarlo.




Si no dispone de acceso a Internet en ese equipo pero si en otra maquina, para activar el
software siga estos pasos:

Escriba el codigo de activacion.
Seleccione la opcion Generate request for license (Generar solicitud de licencia) y
haga clic en Apply (Aplicar).

e El programa License Administration le solicitard un nombre de archivo. Elija un
nombre para el archivo y haga clic en Guardar.

e Transfiera el archivo que acaba de guardar a otro equipo que disponga de
acceso a Internet.

e Haga doble clic en el archivo para abrirlo con el navegador.

e Haga clic con el botdn derecho del ratén en el enlace del archivo que acaba de abrir
y seleccione Guardar destino como... Acto seguido, seleccione una ubicacion para
guardar el archivo de licencia.

e Vuelva a copiar el archivo de licencia en el equipo portatil o estacion de trabajo para el
gue desea obtener la licencia.

e En la License Administration Utility, seleccione la opcion Import file (Importar archivo)
y haga clic en Apply (Aplicar).

e Busque el archivo de licencia XML guardado y abralo.

1.5 Intercambiar con otros sistemas cartuchos LTO formateados como LTFS

La principal ventaja del formato LTFS es la posibilidad de intercambiar cartuchos LTO con varios
sistemas, inclusive de distintos fabricantes:

e Transferir de otro sistema a XenData6 Workstation. Esto incluye transferir un cartucho
LTFS desde un sistema que no es de XenData. Inserte simplemente el cartucho en la unidad
de cinta que esté conectada. Automaticamente, el software realizar4 las siguientes
operaciones: reconocer el cartucho como LTFS, determinar el contenido de los archivos y
carpetas a partir de la particion del indice, y crear un catalogo de la cinta y almacenarlo en
la unidad de disco duro de la estacion de trabajo. Hecho esto, se podran grabar y restaurar
archivos en el cartucho.

o Transferir de XenData6 Workstation a otro sistema. Esto incluye transferir un cartucho
LTFS a un sistema que no es de XenData. Extraiga el cartucho de la unidad de cinta y
transfiéralo al nuevo sistema.

Cada vez que se graba, elimina o renombra un archivo, se graban datos en la cinta LTO. Después
de grabar datos en una cinta formateada como LTFS en otro sistema, si desea trasladarla de nuevo
a un sistema XenData6 Workstation que ya la reconocia, seleccione la opcion Dejar de reconocer
la cinta (Forget this Tape) (4.5) antes de introducirla de nuevo en el sistema.




1.6 Intercambiar con otros sistemas cartuchos LTO formateados como TAR

Los cartuchos de cinta que se graban con TAR se pueden intercambiar entre sistemas XenData6
Workstation y otros sistemas de XenData.

Transferir de un sistema XenData6 Workstation a otro sistema XenData6 Workstation.
Cuando una cinta finalizada se traslada por primera vez a otro sistema XenData6
Workstation, automaticamente el otro sistema lee el catalogo de la cinta y los datos del
catalogo se almacenan en la unidad C:. Con una cinta finalizada, el contenido
automaticamente queda disponible para ser restaurado en el otro sistema. Sin embargo, si
la cinta no esta finalizada, es necesario analizarla para reconstruir los datos del catalogo.
Esto se realiza mediante la funcidn Build Catalog (Crear catélogo) (5.2) .

Transferir de un sistema XenData6 Workstation a un sistema XenData6 Server. Si la
cinta estéa finalizada, el sistema del servidor lee automaticamente el catalogo de la cinta y el
administrador debe utilizar la opcion Import Folder Structure (Importar estructura de carpetas)
para hacer que el contenido de la cinta esté disponible en el sistema de archivos del servidor.
Si la cinta no esta finalizada, primero es necesario crear el catalogo en el sistema del servidor
mediante la funcién Build Catalog (Crear catalogo).

Transferir de un sistema XenData6 Server a un sistema XenData6 Workstation. Sila
cinta esta finalizada, el sistema de la estacion de trabajo lee automaticamente el catalogo de
la cinta. El contenido del cartucho de cinta queda automaticamente disponible para ser
restaurado en el sistema de la estacion de trabajo. Si la cinta no esté finalizada, primero es
necesario crear el catalogo en el sistema de la estacion de trabajo mediante la funcién Build
Catalog (Crear catalogo) (5.2).

Transferir de un sistema XenData6 Workstation a un sistema XenData Server Version
5. Las cintas finalizadas que se hayan creado en un sistema XenData6 Workstation no se
pueden transferir a un sistema XenData Server Version 5. Sin embargo, si es posible transferir
las cintas no finalizadas. Si la cinta no esté finalizada, primero es necesario crear el catalogo
en el sistema del servidor y luego usar la funcién Import Folder Structure (Importar estructura
de carpetas).

Transferir de un sistema XenData Server Version 5 a un sistema XenData6
WorkStation. Si la cinta esta finalizada, el sistema de la estacion de trabajo lee
autométicamente el catadlogo de la cinta. El contenido del cartucho de cinta queda
autométicamente disponible para ser restaurado en el sistema de la estacion de trabajo. Si la
cinta no esta finalizada, primero es necesario crear el catdlogo en el sistema de la estacion de
trabajo mediante la funcién Build Catalog (Crear catélogo) (5.2).

Cada vez que se graba, elimina o renombra un archivo, se graban datos en la cinta LTO. Después
de grabar datos en una cinta formateada como TAR en otro sistema, si desea trasladarla de nuevo
a un sistema XenData6 Workstation que ya la reconocia, siga estos pasos:

e Use la funcion Dejar de reconocer la cinta (Forget this Tape) (4.5) antes de volver
a insertarla en el sistema.
Inserte la unidad de cinta.
Reconstruya el catadlogo con la funcion Rebuild Catalog
(Reconstruir catalogo) (5.2).
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1.7 Acerca de la restauracion parcial de archivos

XenData6 Workstation no puede restaurar archivos parciales. Sin embargo, se puede utilizar para
archivar los archivos en cartuchos LTO que sean compatibles con la restauracién parcial al
trasladar los cartuchos a un sistema XenData6 Server. Para poder realizar restauraciones
parciales, la cinta debe estar formateada con un conjunto de voliumenes que tenga activada la
fragmentacion de archivos. Hallara méas informacion al respecto en los apartados Acerca de la
fragmentacion de archivos (2.4), Acerca de los conjuntos de volimenes (2.1) y Como configurar un
nuevo conjunto de voliumenes (2.6).

1.8 Acerca de la proteccion de bloques légicos

La proteccion de bloques légicos (LBP) completa verifica en tiempo real los datos grabados en la
unidad LTO. El software XenData6 Workstation calcula un valor CRC (prueba de redundancia
ciclica) y lo inserta al final de cada bloque lo6gico de datos grabados en la LTO. Este valor se compara
en tiempo real con el valor CRC determinado por el cabezal de lectura tras la grabacién (read-after-
write) de la unidad LTO para asegurarse de que los archivos se han grabado sin dafios.

La proteccién de bloques l6gicos completa utiliza una funcionalidad introducida por primera vez por
IBM en las unidades LTO-5 y por HP en las unidades LTO-6. Por tanto, no esté disponible en las
unidades de generaciones anteriores. Para activar o desactivar la proteccién de bloques légicos
(LBP) completa, véaseComo configurar la proteccion de blogues légicos (2.8).

1.9 Acerca de la busqueda de archivos
Esta version de XenData6 Workstation no es compatible con la funcién de busqueda del
Explorador de Windows para buscar archivos almacenados en cintas LTO. En su lugar, debe
utilizarse el Informe File Search (6.5).

1.10 Cémo ver la version del software

Para determinar la versiéon de XenData6 Workstation, siga estos pasos:

e Haga clic con el botdn derecho del raton en LTO Drives que se encuentra en el panel izquierdo
del Explorador de Windows.

e Seleccione Propiedades.

e Seleccione la ficha General.

Aqui aparece la version.
1.11 Idiomas compatibles

Esta version de XenData6 Workstation solo esta disponible en inglés.
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2. Conjuntos de volimenes y formateo de cintas
2.1 Acerca de los conjuntos de voliumenes

Un conjunto de volimenes es un grupo de cintas que el sistema trata de la misma forma. Cuando
se formatea una cinta con XenData6 Workstation, esta es asighada a un conjunto de volimenes
seleccionado y se definen una serie de propiedades:

Nombre del conjunto de volimenes

Tipo de almacenamiento: regrabable o WORM

Sistema de archivos: LTFS o TAR

Tamafo de los bloques. Para obtener mas informacion, véase Acerca del tamafio de los
blogues (2.3).

e Activacion de la fragmentacion de archivos y tamafio de los archivos fragmentados. Para
obtener més informacion, véase Acerca de la fragmentacion de archivos (2.4).

Cuando se transfieren varias cintas de un conjunto de volimenes a un sistema XenData6
Server, todas ellas aparecen agrupadas en ese mismo conjunto de voliumenes en el panel
de administracién de XenData.

Al instalar por primera vez el software XenData6 Workstation, el sistema tiene dos conjuntos de
volimenes preconfigurados:

e LTFS predeterminado
* TAR predeterminado

Estos conjuntos de voliumenes preconfigurados satisfacen las necesidades de la mayoria de los
usuarios. No obstante, si desea configurar un nuevo conjunto de volimenes, consulte Cémo
configurar un conjunto de volimenes (2.6).

2.2 Acerca de los codigos de barras y de los nombres de los volumenes de cintas

A los cartuchos de cinta LTO se les pueden colocar etiquetas de codigos
de barras, tal como se muestra en la imagen.

< iw\ T

Las etiquetas de cédigos de barras son el método preferido para llevar el control de las bibliotecas
de cintas, y por eso la mayoria de las bibliotecas ya incluyen un lector de codigos de barras. Las
unidades de cinta independientes no pueden leer las etiquetas de codigos de barras, pero si que
pueden leer el chip de memoria que llevan todos los cartuchos de cinta LTO. Cuando una cinta
LTO que tiene etiqueta de cédigo de barras se formatea en una biblioteca de cintas bajo el control
de XenData6 Server, el software graba la informacion del codigo de barras en el chip de memoria
del cartucho. De esta forma, XenData6 Workstation puede mostrar la informacion del cédigo de
barras en el Explorador de Windows.
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Cuando un cartucho de cinta se formatea con XenData6 Workstation, se le asigha una
etiqueta de volumen. En tal caso, en el Explorador de Windows aparece la etiqueta del
volumen. Para obtener mas informacion, véase Cémo formatear una cinta (2.7).

La siguiente imagen muestra dos cintas en el Explorador de Windows. La primera se identifica
por el cédigo de barras, ya que originalmente se formateé en una biblioteca de cintas
administrada por XenData6 Server. La segunda se formate6 con XenData6 Workstation y recibi6
la etigueta de volumen 'LTO5_002'.

4 M Computer
&, 05(Cy)
b =y HP_RECOVERY (D:)
: ‘ LTO Drives
o & LTO Shelf
@ Barcode:X0014AL4
a LTO5_002

v el Network

2.3 Acerca del tamafio de los bloques
En las LTO, los datos se escriben en bloques. El tamafio de esos bloques

viene determinado por el estandar LTFS y puede ser de hasta 524 288 bytes. En LTFS siempre
se utiliza el tamafio predeterminado, conforme a lo estipulado por dicho estandar.

El formato TAR puede usar varios tamafios. Cuando un cartucho LTO se formatea como TAR
con XenData6 Workstation, el tamafio de los bloques viene definido por el conjunto de
volimenes seleccionado. Nuestra recomendacién es wusar el tamafio de bloques
predeterminado, ya que proporciona transferencias de alta velocidad a la hora de archivar y
restaurar, ademas de aprovechar mejor la capacidad util.

2.4 Acerca de lafragmentacién de archivos

La fragmentacion de archivos en cinta LTO permite restaurar archivos parcialmente al trasladar
una cinta a un sistema XenData6 Server. Si esta activada la fragmentacion de archivos, cada
archivo que supere el tamafio de fragmentacion se «dividird» en varios archivos fragmentados
antes de grabarse en cinta. Una vez restaurado, el software de XenData concatena de manera
transparente los archivos fragmentados para reconstruir el archivo original.

XenData6 Workstation no es capaz de realizar restauraciones parciales, pero XenData6 Server
si. En todas aquellas cintas que se trasladen a una biblioteca administrada por XenData6 Server
para realizar restauraciones parciales, es preciso activar la fragmentacién de archivos.

En los conjuntos de volumenes la fragmentacién de archivos esta activada y es necesario definir
el tamafio de la fragmentacion. Normalmente, se recomienda definir un valor de entre 5 y 10 GB.
Para saber cémo configurar la fragmentacion de archivos, véase Coémo configurar nuevos
conjuntos de volimenes (2.6).

2.5 Acerca de la distribucién en varias cintas

Esta version de XenData6 Workstation no permite abarcar transferencias de archivos en varias
cintas.
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2.6 Cémo configurar un conjunto de volumenes

Los conjuntos de voliumenes se abordan en Acerca de los conjuntos de volimenes (2.1). Al
formatear una cinta, se aplican las propiedades definidas para el conjunto de volimenes. Para
obtener mas informacion, véase Como formatear una cinta (2.7).

Para configurar un nuevo conjunto de volimenes, siga estos pasos:

e Haga clic con el boton derecho del ratén en la opciéon LTO Drives (Unidades LTO) del panel
izquierdo del Explorador de Windows.

e Seleccione Properties (Propiedades).

e Seleccione la ficha Volume Sets (Conjuntos de volimenes).

¢ Haga clic en New (Nuevo) y seleccione el nuevo conjunto de volimenes que aparece en el
panel All Volume Sets (Todos los conjuntos de volimenes).

e Configure las opciones Name (Nombre), LTFS o TAR, Block Size (Tamafio de bloques),
Fragmentation (Fragmentacion), y Rewritable (Regrabable) o WORM.

e Haga clic en Apply (Aplicar).

Todo ello aparece ilustrado en la imagen.

A LT0 Drives Properties R

| General | Volume Sets |Hardware

All volume sets

Default LTFS
Default TAR

Name Italian Project Tape Pool

Volume Set properties

Identitiy 50EEOF2D-00000002
File system Media type Block size
TAR v Rewritable v Default

[]Enable fragmentation

2.7 Como formatear una cinta

Inserte en una unidad de cinta disponible el cartucho de cinta LTO que desee formatear. Al cabo
de dos minutos, el cartucho de cinta aparecera identificado en el panel izquierdo del Explorador de
Windows. Haga clic con el botén derecho del raton sobre el cartucho y seleccione Format...
(Formatear...).

& » Computer » LTO Drives » v |3 W Search LTO Drives o)
Organize v e He @
New »
¥ fapite: Rebuild Catalog -
- S~
45 Libraries finslie LTOS
| Documer format ; 001(8)
& Music bedt
- &) Pictures cut
B8 Videos Copy
Paste
4% Computer
& 0s(C) ik
s HPRECQ  New »
EY. (ST o P—
» g LTOS 0L
A LTO Sheif
€ Network
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Aparecera una ventana en la que podra seleccionar un conjunto de volimenes y una etiqueta de
volumen.

Format Tape 2

j' You have chosen to format a tape that contains data. If
‘,-’ ¥ % you proceed with this operation by dlicking "OK", all the
data on the tape will be irretrievably lost.
Select a Volume Set for this tape

Default LTFS v

Volume Label

Barcode:01643BL6

{ OK ][ Cancel ]

El conjunto de volimenes determina los pardmetros del formato, que incluye el sistema de
archivos TAR o LTFS, el tamafio de bloques de la cinta, y la activacion de la fragmentacion de
archivos. Para obtener mas informacién, véanse Acerca de los conjuntos de volumenes (2.1) y
Como configurar nuevos conjuntos de volumenes (2.6). Después de seleccionar el conjunto de

volimenes y de definir la etiqueta de volumen, haga clic en OK (Aceptar). El sistema procedera a
formatear la cinta.

2.8 Como configurar la proteccién de bloques légicos

La proteccion de bloques légicos se aborda en Acerca de la proteccién de blogues Iégicos. Para
activar o desactivar la proteccion de bloques l6gicos, siga estos pasos:

e Haga clic con el boton derecho del ratén en LTO Drives que se encuentra en el panel
izquierdo del Explorador de Windows.

Seleccione Propiedades.
Seleccione la ficha Hardware.
Seleccione la unidad de cinta que desee.

Margue la casilla Logical Block Protection (Proteccién de bloques logicos) para activarla o
desactivarla. En la imagen siguiente aparece activa.
e Haga clic en Apply (Aplicar).

‘ JGeneralrl Volume Sets‘ Hardware ‘

Managed tape drives
(1M ULTRIUM-HH6  DSED 10WT033409

Hardware Status

Drive state Ready

Current Medium Barcode:016448
Time since Unknown

Data since cleaned 1189014 MB
Last alert None

Logical Block Protection /] Enable

T
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3. Archivado y restauracién de archivos

3.1 Archivar archivos en una LTO

Las operaciones de archivado y restauracion siempre se realizan con el Explorador de Windows.
Esto significa que los archivos no se pueden archivar directamente en LTO con otros programas.
XenData6 Workstation amplia las funciones del Explorador de Windows para transferir archivos a o
desde una unidad de cinta LTO mediante arrastrar y colocar, o copiar y pegar. El sistema mantiene
las estructuras de archivos y carpetas, por lo que es posible transferir carpetas anidadas a o desde
la cinta LTO.

Antes de copiar un archivo o carpeta en una cinta, conviene asegurarse de que haya un cartucho
en la unidad de cinta. La cinta aparecera bajo LTO Drives (Unidades LTO) en el panel izquierdo del
Explorador de Windows; la estructura de carpetas se puede desplegar tanto en el panel izquierdo
como en el derecho.

Para archivar datos en una LTO, solo hay que copiar o cortar los archivos o carpetas necesarios
desde cualquier unidad légica o recurso compartido de red y pegarlos en la estructura de
carpetas de la cinta LTO. Si lo prefiere, también puede arrastrar los archivos hasta la estructura
de carpetas. Durante la operacion de archivado aparecera una barra de progreso, tal como se
ilustra a continuacion. Normalmente, el proceso siempre sera mas rapido que lo estimado por
el Explorador de Windows.

Organize v New Folder ] ¥ l@)

4 Libraries
|5 Documents
@' Music
= Pictures
¥ Videos

18 Computer

&os@ Copying 9 items (8.06 GB)
= HP_RECOVERY (D:)
e BLACKUSB (F:) Name: 943MB_May_2006.avi
‘ LTO Drives From: Venice nested files (C:\Use...\Venice nested files)
To: archive_002 (Computer\LTO Driv...\archive_002)
ca LT05.002 Time remaining: About 2 Minutes and 45 Seconds
. archive_002 Items remaining: 1 (243 MB)
o1 Speed: 81.0 MB/second

;02 |
03
04 (A) Fewer details Pause H Cancel ]

5 items

Al archivar varios archivos en una LTO, la operacion se puede pausar o cancelar en cualquier
momento haciendo clic en los botones Pause (Pausa) o Cancel (Cancelar). Esto no afecta al
archivo que se esté grabando en ese momento en la LTO.

XenData6 Workstation permite sobrescribir, eliminar y renombrar archivos con los métodos
estandar del Explorador de Windows. En la cinta, los archivos se pueden sobrescribir con los dos
métodos habituales de Windows: copiar y pegar, y arrastrar y colocar. En ambos casos, aparece

16 |



3.2

una ventana para confirmar o cancelar la operacién. Una vez sobrescritos, en la cinta quedan
almacenadas las nuevas versiones de los archivos, que son las Gnicas que quedaran disponibles
para futuras restauraciones.

En una LTO se pueden copiar carpetas vacias, tanto en formato TAR como LTFS.

A diferencia de cuando se graba en un volumen de disco NTFS, se aplican las tres
restricciones siguientes:

e En la LTO no se graban las secuencias de datos alternativas. Las secuencias de datos
alternativas permiten asociar a un archivo una o varias secuencias adicionales ademas de la
secuencia de datos principal. Al archivar en una LTO archivos con secuencias de datos
alternativas mediante XenData6 Workstation, la secuencia de datos principal se graba en la
LTO, pero no las secuencias de datos alternativas.

e En la LTO no es posible cambiar el nombre de una carpeta si esta contiene archivos o
subcarpetas.

e No se pueden copiar archivos con un tamafio de cero bytes.

Restaurar archivos de unaLTO

Las operaciones de archivado y restauracion siempre se realizan con el Explorador de Windows.
Esto significa que los archivos no se pueden restaurar directamente de la LTO con ningun otro
programa. XenData6 Workstation amplia las funciones del Explorador de Windows para transferir
archivos a o desde una unidad de cinta LTO mediante arrastrar y colocar, o copiar y pegar. El
sistema mantiene las estructuras de archivos y carpetas, por lo que es posible transferir carpetas
anidadas a o desde la cinta LTO.

Antes de restaurar un archivo o carpeta de una cinta, conviene asegurarse de que haya un cartucho
en la unidad de cinta. La cinta aparecera bajo LTO Drives (Unidades LTO) en el panel izquierdo del
Explorador de Windows; la estructura de carpetas se puede desplegar tanto en el panel izquierdo
como en el derecho.

Para restaurar datos de una LTO, simplemente copie los archivos de la estructura de carpetas
de la cinta LTO y péguelos en cualquier unidad légica o recurso de red disponible. Si lo prefiere,
también puede arrastrar los archivos hasta la estructura de carpetas. Durante la restauracion
aparece una barra de progreso. Normalmente, el proceso siempre sera méas rapido que lo
estimado por el Explorador de Windows.

KB | < Graphics » videofiles » =

Organize v New Folder

- Favorites
4 Libraries

/% Computer

&, Local Disk (C:) = Processing

a Video Archive (E:) 2 ; b :

LTO Drives Copying ‘Venice2\943MB_May_2006.avi'

s Graphics
To 'C:\Users\XenData6\Desktop\restore'

LTO Shelf About 2 Minutes and 45 Seconds remaining

ggp—

95( Network

Venice2
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4. Cintas sin conexion
Acercade las cintas sin conexiéon

Cuando son expulsadas de una unidad, las cintas pasan a estar sin conexién. XenData6
Workstation conserva informacién sobre la estructura de archivos y carpetas de todas las
cintas sin conexién. De todos modos, no es posible restaurar los archivos hasta que la cinta
se vuelve a insertar en la unidad.

Las cintas sin conexién aparecen en el panel izquierdo del Explorador de Windows bajo LTO Shelf
(Estanteria LTO). La estructura de archivos y carpetas almacenados en las cintas sin conexion se
puede ver tanto en el panel izquierdo como en el panel derecho del Explorador de Windows. Esta
funcion se explica en Acerca de la estanteria LTO (4.4).

También se pueden elaborar informes para listar el contenido de cualquier cinta sin conexion, las
ubicaciones de las cintas sin conexién en busca de archivos que cumplan unos determinados
criterios y el estado de todas las cintas sin conexion.

Existe una opcion para eliminar los datos sobre una cinta sin conexién. Esta operacion se realiza
con la funcién Dejar de reconocer la cinta (Forget this Tape) (4.5).

4.2 Como ver las propiedades de un cartucho LTO

Para ver las propiedades de cartuchos LTO, tanto de las cintas que estan en una unidad de cinta
como de las cintas sin conexion, siga estos pasos:

Abra el Explorador de Windows.
Haga clic con el botén derecho del ratén en la cinta que aparece bajo LTO Drives (Unidades
LTO) o LTO Shelf (Estanteria LTO) en el panel izquierdo y seleccione Properties
(Propiedades).

e Seleccione la ficha General o la ficha Cartridge (Cartucho).

En la imagen siguiente se muestran las propiedades disponibles.

. Barcode:01643BL6 Properties R

General | Cartridge \

Barcode:01643BL6
Type: LTO Tape
File system: LTFS

Used Space 7,340,032 bytes 7MB
Free Space 2,463,225,610,240 bytes 2.24TB
Capadty 2,463,232,950,272 bytes 2.24TB

{ oK ] [ Cancel Appl
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. Barcode:01643BL6 Properties =

@@ Cartridge ‘
Manufacturer Information
Manufacturer FUJIFILM
Serial number ADAET 1KRX8
Type Rewritable
Date 11/08/12
Cartridge Information
Medium Name Barcode:01643BL6
Medium Identity Barcode:01643BL6
Volume ID SOEEOF2D-00000000-514CD736
State Writable

Format Information

Volume Set Default LTFS
Block size 0 bytes
Fragmentation Disabled
Volume spanning Disabled

4.3 Como expulsar un cartucho de launidad LTO

Cuando se expulsa un cartucho de una unidad LTO, este pasa a estar sin conexién. Ya no
aparecera bajo LTO Drives (Unidades LTO) en el Explorador de Windows, pero seguira
apareciendo bajo LTO Shelf (Estanteria LTO).

Para expulsar un cartucho LTO de una unidad de cinta, pulse el boton de expulsion de la unidad o
bien seleccione la unidad de cinta en el panel izquierdo del Explorador de Windows y haga clic en
Eject (Expulsar), tal como se muestra a continuacion.

e
@ (el s <« LTODri... » LTO5002 » = Search LTO5.002 |

Organize v Expand 3 v (2]

- Favorites New .4 archive 002

Rebuild Catalog

4 Libraries Finalize
5| Document{ Format...
& Music Eject
[ Pictures =
B Videos S
Copy
4% Computer feste
& 05(C) Rename
s HP_RECOV/
o BLACKUSE MW ’
4 ‘ LTO Drives| Properties
> s LTO5.002
A& LTO Shelf
> €l Network
) archive_002

4.4 Acerca de la estanteria LTO

LTO Shelf (Estanteria de LTO), que aparece en el panel izquierdo del Explorador de Windows,
contiene todas las cintas que reconoce el sistema, incluidas las que en ese momento se
encuentran en una unidad de cinta.

La estructura de carpetas y archivos almacenados en una cinta se puede expandir en los
paneles izquierdo y derecho del Explorador de Windows, tal como se muestra a continuacion.
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» Computer » LTO Shelf » Barcode:X0012AL4 » Venice nested files » 01 v |49 ll Search Ol Pl

Organize ¥ New Folder §= v @

Name Date modified Cartridge Name Barcode Block Number

1% Computer
& os@
(s HP_RECOVERY (D)
= BLACK USB (F))
& LTO Drives
& LTO Shelf
s Barcode:X0012AL4
Archive 124
Venice nested files | =
01
02
[}
04
s Barcode:X0014AL4
ca LT05.002

[B) 1.3.86B-May_2006.avi 1/3/2008
392MB_May_2006.avi 1

.
=) 943MB_May_2006.avi 1,

33 AM
AM
AM V

) 3 items

Las cintas sin conexion se pueden quitar de LTO Shelf (Estanteria LTO) mediante la
funcion Forget this Tape (Dejar de reconocer esta cinta), tal como se explica en Coémo
dejar de reconocer una cinta (Forget this Tape) (4.5).

4.5 Como dejar de reconocer una cinta (Forget this Tape)

LTO Shelf (Estanteria LTO) muestra la estructura de carpetas y archivos de todas las cintas que
reconoce el sistema. Para quitar una cinta y su estructura de carpetas y archivos de LTO Shelf,
use la funcién Forget this Tape (Dejar de reconocer esta cinta) tal como se explica a continuacion:

e Asegurese de que la cinta esté sin conexidn. Si es preciso, expulsela de la unidad tal como se
describe en Cémo expulsar una cinta (4.3).

e Haga clic con el bot6én derecho del ratén en la cinta bajo LTO Shelf (Estanteria LTO) en el
panel izquierdo del Explorador de Windows y seleccione Forget this Tape (Dejar de reconocer
esta cinta).

En la imagen siguiente se ilustra el proceso.

4 % Computer
&, os(C)

» @ HP_RECOVERY (D:)

" ey BLACK USB (F:)

4 & LTO Drives
> Barcode:X0012AL4

4 ff LTO Shelf
@ Barcode:X0012AL4

b a Ba T |
= Expand
ca LT|
Forget this Cartridge
6‘! Netwdi Cut
| Copy
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5. Catalogos y finalizacion de cintas

5.1 Acerca de los catalogos de cintas

Un catdlogo de cinta muestra el contenido de un cartucho de cinta LTO especifico. En la
documentacién de XenData, se denomina «catalogo de contenidos de una cinta» o, simplemente,
«catélogo de cinta».

Al formatear un cartucho LTO como TAR o LTFS, se crean los datos del catédlogo de cinta'y
guedan almacenados en la carpeta c:\ProgramData\XenData\catalogs\.

Cuando se finaliza (5.3) una cinta formateada como TAR, al final de esta se graba un catalogo de
cinta. El catalogo de cinta reduce considerablemente el tiempo que se tarda en trasladar una cinta
con formato TAR de un sistema XenData a otro. Cuando un cartucho con formato TAR que contiene
un catélogo de cinta se traslada por primera vez a otro sistema, el nuevo sistema lee el catalogo
de cinta y almacena automaticamente los datos del catalogo. Gracias a esto, no es necesario
reconstruir el catalogo (5.2), una operacion que puede durar varias horas.

La operacién de finalizacion no es aplicable a un cartucho formateado como LTFS, porque el
contenido del cartucho se encuentra en la particion del indice. Cuando un cartucho con formato
LTFS se traslada por primera vez a otro sistema, este lee la pequefia particion del indice y
obtiene rapidamente el contenido.

5.2 Creacidén y reconstruccion de un catalogo

Cuando se finaliza (5.3) una cinta con formato TAR, al final de esta se graba automaticamente un
catalogo de cinta (5.1). Al trasladar por primera vez una cinta finalizada a otro sistema XenData,
el nuevo sistema lee el catdlogo de cinta y los datos de catalogo de cinta quedan almacenados
autométicamente en la unidad C: del sistema. Sin embargo, si la cinta no esta finalizada, es
necesario analizarla para reconstruir los datos del catalogo. Esto se realiza mediante la funcion
Build Catalog (Crear catalogo).

Si una cinta que el sistema ya reconoce es modificada en otro sistema, ya sea grabando, borrando
o renombrando uno o varios archivos, es necesario realizar estos pasos:
e Use la funcion Forget this tape (Dejar de reconocer la cinta) antes de volver a insertarla en el
sistema.
¢ Insértela en la unidad de cinta.
¢ Sitiene formato TAR, reconstruya el catalogo mediante la funcién Rebuild Catalog.

Para crear o reconstruir los datos del catalogo, haga clic con el boton derecho del ratén en la
cinta bajo LTO Drives (Unidades LTO) del panel izquierdo del Explorador de Windows y
seleccione Build Catalog (Crear catélogo) o Rebuild Catalog (Reconstruir catalogo), tal como se
ilustra a continuacion.

& » Comouter » LTO Shelf

Expand
Organize v|
New »
¥ Favorit B i Catalog
Finalize
4 4 Librarig
Format...
<| Docu i
B | Eject
@' Musi
[ Pictu Cut
B Videc Copy
Paste
4 M Compy
P Rename
i 0S(C
ca HPR New »
- BLAG Properties
4 LTO brwves
(= Barcode:X0012AL4 (No Catalog)
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5.3 Acerca de la finalizacién de cintas

La operacion de finalizacién es aplicable Gnicamente a los cartuchos con formato TAR (no al
formato LTFS).

Cuando se finaliza una cinta con formato TAR, al final de esta se graba un Catalogo de contenidos
de la cinta (5.1), seguido de unas marcas especiales que impiden la grabaciéon de mas archivos
en la cinta. Al llegar al 98 % de su capacidad, XenData6 Workstation finaliza las cintas
automaticamente. Las cintas parcialmente llenas también se pueden finalizar. Para obtener mas
informacion, véase Cémo finalizar las cintas (5.4).

El catalogo de cinta reduce considerablemente el tiempo que se tarda en trasladar un cartucho
LTO con formato TAR de un sistema XenData a otro. Al trasladar por primera vez una cinta con
formato TAR que no ha sido finalizada (y que, por tanto, no contiene ningln catalogo) a otro
sistema XenData, es preciso crear los datos del catalogo en el nuevo sistema mediante la
funcién Build Catalog (5.2). El proceso puede durar varias horas. En cambio, si la cinta esta
finalizada, la operacion es automética y solo dura unos minutos.

5.4 Cémo finalizar una cinta

La operacion para finalizar una cinta se explica en Acerca de la finalizacion de cintas (5.3). Cuando
una cinta con formato TAR llega al 98 % de su capacidad, el sistema la finaliza autométicamente.
Para finalizar una cinta con formato TAR que esta parcialmente llena, siga estos pasos:

e Asegurese de que la cinta que desea finalizar se encuentre en la unidad y que aparezca bajo
LTO Drives (Unidades LTO) en el panel izquierdo del Explorador de Windows.

e Haga clic con el botdn derecho del raton en la cinta bajo LTO Drives y seleccione Finalize
(Finalizar).

En la imagen siguiente
se ilustra el proceso.

+ . » Comnuter » ITO Drives » Barcode:X0012AL4 »
Collapse

Organize {
New »

- d Archive_12A
I Favorn Rebuild Catalog

Finalize

Venice nested files

§ 'N_Libm Format...
-5 Doc
Jr Mug
[ Pict Cut

E Vide Copy

Paste

Eject

418 Comg Rename =
& os 8
ca HP_ New »

4 ‘ L19 Properties

]

Archive_12A
4 Venice nested files
01
02
03
04
& LTO Shelf
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6. Report Generator
6.1 Acerca de Report Generator
Con XenData6 Workstation Report Generator se pueden crear los siguientes tipos de informes:

e Archive Status. Muestra la capacidad y el espacio libre de todos los cartuchos de cinta
reconocidos por el sistema.

e File Search. Muestra los archivos que coinciden con unos determinados criterios de
bldsqueda y las cintas donde se encuentran dichos archivos.

e Tape Cartridge Contents. Muestra todos los archivos de todos los cartuchos de cinta
reconocidos por el sistema. La lista se puede filtrar con los criterios de busqueda que
determine el usuario.

Los informes se pueden guardar en distintos formatos, entre los que se incluye un archivo de
texto que puede importarse en Microsoft Excel.

6.2 Abrir Report Generator

Para abrir Report Generator, siga estos pasos:

e Windows 7:
o Haga clic en Inicio > Todos los programas > XenData.
o Haga clic en Reports (Informes) tal como se muestra a continuacion.
e Windows 8.1y Windows 10:
o Abra la pantalla Inicio y haga clic en la flecha abajo de la esquina inferior izquierda
para abrir la vista de aplicaciones.
o Haga clic en Reports (Informes) debajo de la seccién de XenData.

[ Windows Media Player

] Windows Update

4 XPS Viewer xendatab
Accessories
Administrative Tools Documents
Bluetooth Devices
Bluetooth Suite Pictures
Catalyst Control Center
Citrix
CutePDF
Games

Music

Games

Maintenance

Microsoft Keyboard
Microsoft Office
Microsoft Silverlight

NEC Electronics

Startup

XenData

‘ Activity Display

&5 Help

License Administration

‘ Reports

4 Back

Computer

Control Panel

Devices and Printers
Default Programs
Administrative Tools »
Help and Support

Run...

Shutdown | > |

Se abrird XenData Report Generator. Haga clic en File (Archivo) y seleccione New (Nuevo)
para crear un nuevo informe o bien Open (Abrir) para abrir un informe ya existente.
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6.3 Generar, guardar y restaurar informes

6.3.1 Generar informes

Abra el programa Report Generator y, en la pagina inicial, seleccione File > New (Archivo >

Nuevo).

[File] View

Help

New

Open.

Print Setup...

1 C:\Users\..\XDReport4. XRG

Close

Exit

Ctrl+N
Ctrl+0

En el menud desplegable, seleccione el tipo de informe que desee.

”
‘ XenData Report Generator

Select a Report Type

Select Volume Set

ive Status

Archive Status

File Search

Tape Cartridge Contents

[AII Tapes

6.3.2 Guardar informes

Los informes se pueden guardar en tres formatos diferentes: Formato de Report Generator
(.XRG), texto delimitado por tabuladores (.txt) o XML. El formato XRG es el Gnico que puede
visualizarse en Report Generator. El formato de texto es (til para exportar los resultados a

Microsoft Excel.

Para guardar un informe, seleccione File > Save As (Archivo > Guardar como).

ﬂ Edit View Winow Help —

C

New
Open...
Close
Save

Save As...

Print...
Print Setup...

1 C:\Users\..\XDReport4.XRG

Exit

Ctrl+N
Ctrl+O

Ctrl+S

Ctrl+P

T

Vaya a la ubicacién que desee, seleccione el nombre y formato del archivo y haga clic

en Save (Guardar).
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6.3.3 Restaurar informes

Report Generator solo muestra los informes guardados con formato XRG.

Abra el programa Report Generator y, en la pagina inicial, seleccione File > Open (Archivo >
Abrir).

New Ctrl+N
Open... Ctrl+0 |
Print Setup...

1 C:\Users\..\XDReport4.XRG

Close

Exit

Vaya a la ubicacién del informe guardado, seleccione el archivo XRG y abralo.

6.4 Informe Tape Cartridge Contents
6.4.1 Cémo generar un informe Tape Cartridge Contents

Abra Report Generator y seleccione File > New (Archivo > Nuevo). A continuacion, seleccione
lo siguiente:

e Tape Cartridge Contents como tipo de informe.

e La cinta por su etiqueta de volumen.

e Criterios de busqueda: seleccione No Search (Sin blusquedas) para mostrar todos los
archivos de la lista seleccionada, o bien File Name Text Search (Busqueda textual de

nombres de archivo) para filtrar los resultados especificando una cadena de texto.
e Eltipo Sort By (Ordenar por) ordena los resultados del informe por la fecha de
grabacion o por el nombre del archivo.

Todo ello aparece ilustrado en la imagen.

‘ XenData Report Generator =
SelectaReport Type | Tape Cartridge Contents v
Select Tape [Graphlrs - ]
Search
Sortby
Search Term
[ Get Report ] [ Close

Haga clic en Get Report (Obtener informe).

El término de busqueda no distingue entre mayusculas y minUsculas, y para separar las
carpetas se puede usar tanto una barra (/) como una barra inversa ( \ ). Si como término
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de busqueda se escribe, por ejemplo, abc, el informe mostrara todos los archivos de la
cinta seleccionada que contengan abc en el nombre del archivo o en la ruta de acceso.

Como caréacter comodin se puede usar un asterisco; por ejemplo, \venice2\*avi buscara todos
los archivos que contengan una carpeta denominada venice2 en la ruta de acceso, seguido
de avi.

6.4.2 Como interpretar un informe Tape Cartridge Contents

A continuacion se muestra un ejemplo de un informe Tape Cartridge Contents.

Report Type: Tape Cartridge Contents

Tape: Graphics

Search Type: None

Sorted by: Date

1 /graphics/Photos/2007/Black Eye/DSCN0965.JPG 0 1 652,947
2 | Igraphics/Photos/2007/Black Eye/DSCN0966 JPG o 4 774546
3 |/graphics/Photos/2007/Black Eye/DSCN0968.JPG 0 E 767,713
4 Igraphics/Photos/2007/Black Eye/Thumbs.db 0 1 16,384
5 | Igraphics/Photos/2007/Cardiff 2007/DSCN0930.JPG 0 E 713,328
6 | Igraphics/Photos/2007/Cardiff 2007/DSCN0932.JPG 0 1 713,537
7 | igraphics/Photos/2007/Cardiff 2007/DSCN0933 JPG lo 1 783,029
8 | igraphics/Photos/2007/Cardiff 2007/DSCN0934 JPG 0 E 754,990
9 | graphics/Photos/2007/Cardiff 2007/DSCN0940.JPG o 1 331910
10 | Igraphics/Photos/2007/Cardiff 2007/DSCN0941 JPG 0 1 557,006
11 ‘ Inranhire/Phntne20N7ICardiff 200 7INSCKANNQAD 1DG n ' 1 77R7 7nA

A continuacion se explica cada columna:

No. Numero del archivo en pantalla (siguiendo el orden de la cinta o por nombre de
archivo, segun lo que se seleccione en el campo Sort By).

File Name. Nombre del archivo, incluida la ruta de acceso.

Generation. La primera vez que se crea un archivo con un nombre y ruta de acceso
determinados, se lo considera de «generacion 0». Cada vez que se elimina el archivo y se
crea otro con el mismo nombre que contiene datos, el sistema incrementa el nUmero de
generacion. Cada vez que se incrementa el nimero de generacién, el archivo nuevo vuelve
atener la version 1.

Version. Si se actualiza un archivo (sobrescribiéndolo o afadiéndole datos), el software
XenData asigna un nuevo namero de versién. Cada vez que se graban datos en un archivo,
el nimero de version se va incrementando. Tenga en cuenta que el nimero de version no se
incrementa con todas y cada una de las operaciones de escritura, sino cada vez que se abre
un archivo y se graba algo en él. La versién 0 de un archivo no contiene ningun dato; la
primera vez que una aplicacion graba algo en el archivo, el nimero de versién se incrementa
enl.

File Size. Tamafio del archivo, expresado en bytes.
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6.5 Informe File Search
6.5.1 Como generar un informe File Search

Abra Report Generator y seleccione File > New (Archivo > Nuevo). A continuacién, seleccione
lo siguiente:

'File Search' como tipo de informe.

'All Volume Sets' o un conjunto de voliumenes determinado.

Search > File Name Text Search y escriba un término de busqueda para buscar archivos
por nombre y ruta de acceso.

Todo ello aparece ilustrado en la imagen.

& XenData Report Generator =

SelectaReportType | Fie Search B

Select Volume Set [Aﬂ Volume Sets ¥ ]

Search

Type |File Name Text Search v

Search Term

\venice2\*avi

e

Haga clic en Get Report (Obtener informe).

El término de basqueda no distingue entre mayUsculas y mindsculas, y para separar las
carpetas se puede usar tanto una barra (/) como una barra inversa ( \ ). Si como término
de busqueda se escribe, por ejemplo, abc, el informe mostrara todos los archivos
archivados que contengan abc en el nombre del archivo o en la ruta de acceso. Como
caracter comodin se puede usar un asterisco; por ejemplo, \venice2\*avi buscara todos
los archivos que contengan una carpeta denominada venice2 en la ruta de acceso,
seguido de avi.

6.5.2 Como interpretar un informe File Search

Un informe File Search muestra todos los archivos que cumplen los criterios de blusqueda.
En la imagen siguiente se ilustra un informe File Search a modo de ejemplo.

Report Type: File Search
Volume Set: All Volume Sets
Search Type: File Name Text
Search: \Venice2\*avi

1 | IX0004A/Venice2/1_3_8GB-May_2006.avi 0 1 1,487,700,480 Barcode:X0004AL4
2 | /X0004A/Nenice2/392MB_May_2006.avi 0 1 411,132,928 Barcode:X0004AL4 ‘
3 [X0004A/Nenice2/943MB_May_2006.avi |0 1 989,532,160 | Barcode:X0004AL4
4 | Venice2/1_3_8GB-May_2006 avi 0 1 1,487,700,480 Barcode:X0003AL4
5 | /Venice2/392MB_May_2006.avi 0 1 411,132,928 Barcode:X0003AL4 ‘
6 | /Venice2/943MB_May_2006.avi 0 1 989,532,160 Barcode:X0003AL4
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A continuacion se explica cada columna:
No. Numero del archivo en pantalla.
File Name. Nombre del archivo, incluida la ruta de acceso.

Generation. La primera vez que se crea un archivo con un nombre y ruta de acceso
determinados, se lo considera de «generacién O». Cada vez que se elimina el archivo y se
crea otro con el mismo nombre que contiene datos, el sistema incrementa el nimero de
generacion. Cada vez que se incrementa el nimero de generacion, el archivo nuevo vuelve
atener la version 1.

Version. Si se actualiza un archivo (sobrescribiéndolo o afadiéndole datos), el software
XenData asigna un nuevo ndmero de version. Cada vez que se graban datos en un archivo,
el nimero de versién se va incrementando. Tenga en cuenta que el niUmero de version no
se incrementa con todas y cada una de las operaciones de escritura, sino cada vez que se
abre un archivo y se graba algo en él. La version 0 de un archivo no contiene ningln dato; la
primera vez que una aplicacion graba algo en el archivo, el nUmero de versién se incrementa
en 1.

File Size. Tamafio del archivo, expresado en bytes.

Volume Label. Etiqueta de volumen del cartucho de cinta donde se encuentra el archivo.

6.6 Informe Archive Status

6.6.1 Como generar un informe Archive Status

Abra Report Generator y seleccione File > New (Archivo > Nuevo). A continuacion, seleccione
lo siguiente:

e Archive Status como tipo de informe.
o All Tapes o bien un conjunto de volumenes especifico.

Todo ello aparece ilustrado en la imagen.

g B
4 XenData Report Generator lﬂ
Select a Report Type [Ard\ive Status v ]

Select Volume Set [AII Tapes v ]
[ Get Report ] [ Close
\

Haga clic en Get Report (Obtener informe).
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6.6.2 Como interpretar un informe Archive Status

La imagen siguiente muestra un informe Archive Status a modo de ejemplo.

Report Type: Archive Status
Tape: All Tapes

1 | Barcode:X0014B | 780.5 |8.07 7725 Writable
2 | Barcode:X0015A | 780.6 269 7779 Wiritable
3 |Jan_20 |781.5 |8.07 | 7735 Writable

A continuacion se explica cada columna:

No. Numero de linea que ocupa la cinta en pantalla.

Volume Label. Etiqueta de volumen del cartucho de cinta.

Capacity (in GB). Capacidad del cartucho de cinta.

Used Space (in GB). Espacio usado del cartucho de cinta.

Free Space (in GB). Espacio libre del cartucho de cinta.

Status. Estado del cartucho de cinta, por ejemplo, Writable (Grabable) o Finalized
(Finalizado).
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7. Diagnéstico de problemas
7.1 Acerca del diagnéstico de problemas

La principal herramienta para diagnosticar problemas es el Visor de eventos de Windows. Para
abrirlo, siga estos pasos:

e Windows 7:
o Haga clic en Inicio.
o Haga clic con el botén derecho del ratén en Equipo y seleccione Administrar.
o Expanda el Visor de eventos en el panel izquierdo y luego Registros de aplicaciones y
servicios.
o Haga clic en XenData.
¢ Windows 8.1 y Windows 10:
o Haga clic con el boton derecho del raton en Inicio.
o Seleccione el Visor de eventos y expanda Registros de aplicaciones y servicios.
o Haga clic en XenData.

En la imagen se muestra el Visor de eventos de XenData.

File Action View Help

s 2B EED

A Computer Management (Local
4 {f} System Tools
b (© Task Scheduler
4 [3] Event Viewer
» [ Custom Views

Level Date and Time Source EventID Task Category *
@Information 2/16/2011 6:00:58 PM  XenData Arc...
(DInformation  2/16/2011 5:01:05PM  XenData Arc...
@Information 2/16/2011 4:48:02 PM  XenData Arc...

0 None
2
¥

» [ Windows Logs @Information 2/16/2011 4:48:01 PM  XenData Arc... 0 None
2
1
0

None
None

4 [ Applications and Se @Information 2/16/2011 4:31:38 PM  XenData Arc... None

] Hardware Events @Information 2/16/2011 3:56:02 PM  XenData Arc... None

E;I Internet Explorer @Infovmation 2/16/2011 3:56:01 PM  XenData Arc... None
& Key Managemer, (DInformation  2/16/2011 3:46:44 PM  XenData Arc... 3125 None
] Media Center (DInformation  2/16/2011 3:46:30 PM  XenData Arc... 20011 None
> 1 Microsoft @Information 2/16/2011 3:44:46 PM  XenData Arc... 1 None
£] Windows Power ||| (i) Information ~ 2/16/2011 3:44:45PM  XenData Arc... 0 None
] XenData (Dinformation  2/16/20113:33:23PM  XenData Arc... 3125 None
< Subscriptions (DInformation  2/16/2011 33150 PM  XenData Arc.. 20011 None
> @l Shared Folders (@ Information  2/16/2011 3:25:55 PM  XenData Arc... 1 None @
& Local Users and Groups || (7 1nformation  2/16/2011 3:25:55 PM  XenData Arc... 0 None =
3 @ Performance <7 I s

a2 Device Manager
4 &5 Storage
=7 Disk Management
> F4 Services and Applications

Event 0, XenData Archive Series b

I General @m

Began initialization of XenData Service version 6.00 dev (Feb 16 2011) (4D5C5AAF).

Log Name: XenData

Source: XenData Archive Series Logged: 2/16/2011 6:00:5)
EventID: 0 Task Category: None

Level: Information Keywords: Classic

User: SYSTEM Computer: Core-i5
OpCode:

More Information:  Event Log Online Help

< 1 »

Asimismo, el Panel de actividades de XenData (7.3) puede ofrecer informacion de diagnostico
en caso de problemas.
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7.2 Estado de la cinta: alerta de XenData

Si el sistema detecta que un cartucho de cinta tiene algin problema que debe corregirse antes
de que se graben mas datos, pondréa la cinta en estado de alerta. En el panel izquierdo del
Explorador de Windows aparecerd la palabra «Alert» junto al cartucho en cuestién.

- AR - - |
9 TN

Organize v New Folder

~a Libraries

X00128

4 M Computer
&, Local Disk (C:)

o SanDisk (E:)
5 All_Users (\\xen-us-03) (S:)
5# Share (\\xen-us-03) (V:)
4 i LTO Drives
& Barcode:X0012B (Alert)
- & LTO Shelf

1 item

Es posible que el problema se solucione seleccionando Reset Alert (Restablecer alerta)
para el cartucho de cinta, tal como se ilustra a continuacion.

Organize v New Folder

su Libraries
4 8 Computer s

&, Local Disk (C:)

> ey SanDisk (E:)

> L@ All_Users (\\xen-us-03) (5:)
& Share (\\xen-us-03) (Vi)

4 i LTO Drives
> = Barcod=:X0N12R (Alert)
& LTO She Expand

Rebuild Catalog

Finalize
Reset Alert
Format...
Eject

Cut

Copy
Paste

Rename

Properties
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Si esto no corrige el problema, consulte el registro de eventos de Windows tal como se explica en
Acerca del diagnostico de problemas (7.1).

Si el catdlogo de contenidos deja de estar sincronizado con el cartucho de cinta real, el sistema
pone el cartucho en estado de alerta. En este caso, en el registro de eventos aparecera el siguiente

mensaje:
Level Date and Time Source EventID TaskC..
{]Error 3/28/2011 1:02:20 PM XenDat... 2055 None
(Dlnformation 3/28/2011 12:48:51 PM XenDat... 3125 None
(@Information 3/28/201112:47:45 PM XenDat... 20011 None
@Information 3/28/2011 10:30:21 AM XenDat... 1 None

Event 2055, XenData Archive Series

General | Deta?l?i

The last written block for cartridge test_28_Mar does not agree with the volume catalog.

Esto ocurre, por ejemplo, cuando se han grabado datos adicionales en el cartucho utilizando
otro sistema.

Para solucionar el problema, reconstruya el catalogo (5.2) y seleccione Reset
Alert (Restablecer alerta).

7.3 Panel de actividades de XenData

Si se produce un problema, el panel de actividades es un recurso de diagndstico Gtil para el
personal técnico de XenData.

00:24:57.560 System Found drive 0 (HP Ultrium 4-SCSI 012.890 HU100790M8) at Port 4 bus 01D 3 LUN 0 ~
00:25:00.601 System System initialization succeeded

00:25:00.927 System Check

00:25:00.927 Drive 0/0 Mount Graphics

00:25:51.730 Drive 0/0 Mount —> SUCCEEDED (50802mS)

00:25:51.730 Drive 0/0 Read 32 blocks at block number 0

00:25:51.753 Drive 0/0 Read —> SUCCEEDED [23mS$; 31KB/sec]

00:25:51.754 Drive 0/0 FindLastBlock

00:26:52.160 Drive 0/0 FindLastBlock —> 8349344

00:26:52.174 System Check —> found file system 4D5C5AAF-00000000-4D6047BE replica 0
09:06:56.102 System WriteStream(0ivideo files\Venice2{1_3_8GB-May_2006.avi, fragment 0 gen. 0, ver.
09:06:56.102 System WriteStream(0jvideo files/¥enice2/1_3_8GB-May_2006.avi-0-0-1)

09:06:56.102 Drive 0/0 Write 2905696 blocks at block number 8349344

09:07:16.509 Drive 0/0 Write —> SUCCEEDED (20407mS; 71192KB{sec)

09:07:16.546 System WriteStream(0ivideo files\Venice24392MB_May_2006.avi, fragment 0 gen. 0, ver. 1
09:07:16.546 System WriteStream(0}video files/Venice2{392MB_May_2006.avi-0-0-1)

09:07:16.546 Drive 0/0 Write 803008 blocks at block number 11255040

09:07:21.599 Drive 0/0 Write —> SUCCEEDED (5053mS; 79457KB/sec)

09:07:21.607 System WriteStream(0tvideo files\Venice21943MB_May_2006.avi, fragment 0 gen. 0, ver. 1
09:07:21.607 System WriteStream(0}video files/Venice2/943MB_May_2006.avi-0-0-1)

09:07:21.607 Drive 00 Write 1932704 blocks at block number 12058048

09:07:33.863 Drive 0/0 Write —> SUCCEEDED ("12256mS; 78846KB/sec)

09:07:33.905 Drive 0/0 Flush cache

09:07:35.270 Drive 0/0 Flush —> SUCCEEDED ("1365mS$)

<« |
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Muestra la interaccion del sistema de archivado con las unidades de cinta LTO. Para abrirlo,
siga estos pasos:

e Windows 7:
o Haga clic en Inicio > Todos los programas > XenData.
o Haga clic en Activity Display (Mostrar actividad).
e Windows 8.1 y Windows 10:
o Abra la pantalla Inicio y haga clic en la flecha abajo de la esquina inferior
izquierda para abrir la vista de aplicaciones.
o En la seccion de XenData, haga clic en Activity Display (Panel de actividades).
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